Chapter 17

Miscellaneous Tools

Learning Objectives

After completing this chapter, you will be able to:
* Find the Center of Gravity of a model

* Extract an iFeature

* Insert an iFeature

¢ Create an iMate

* Understand the use of iProperties

* Create user-defined drawing sheets

* Import AutoCAD blocks into Inventor
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INTRODUCTION

In this chapter, you will learn about some of the tools that help in enhancing your
working efficiency while creating a part.

COPYING THE SKETCHES

Ribbon: Sketch > Modify > Copy

0% Copy The Copy tool is available in the sketching
& environment and allows you to copy the sketched
entities from one location to the other. Note that if dimensions
are also selected along with the entities to be copied, then B Ceredse mput
the selected dimensions will also be copied along with the | 00 0o
sketched entities. To copy the sketched entities, invoke the H
Copy tool from the Modify panel of the Sketch tab; the Copy
dialog box will be displayed, as shown in Figure 17-1. The Figure 17-1 The Copy dialog box
options in this dialog box are discussed next.

Copy X

Select fz | @< BasePoint

Done

Select

This button is used to select the entities to be copied. On invoking the Copy tool, this button is
automatically chosen and you are prompted to select the geometry to copy. You can select individual
entities using the mouse button or select more than one entity using the Window or Crossing options.

Base Point

This button is chosen to specify the point that will act as the base point for moving the copied
entities. Once you have selected all the entities to be copied, choose this button to select the
point from where the movement will start.

Clipboard [Ctri-C]

This check box, if selected, temporarily saves the selected geometry or the clipboard so that
after choosing the Done button, you can paste the selected geometry by pressing CTRL+V
keys from the keyboard.

Precise Input
This check box, if selected, allows you to specify the coordinates for the base point and the
destination point using the Inventor Precise Input toolbar.

Optimize for Single Selection

If this check box is selected, the Base Point button will be activated automatically after making a
single selection or the window selection of geometry. But if you clear this check box, you can
make multiple geometry selections before choosing the Base Point button.

After selecting the geometry and the base point, you will be prompted to specify the endpoint for
copy. Specify the end point in the graphics window; the copied geometry will be pasted. You
will notice the Copy tool is still active. If you need multiple copies, specify more endpoints, else
right-click and choose Cancel(ESC).
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SCALING THE SKETCHES

Ribbon: Sketch > Modify > Scale

The Scale tool is available in the sketching
E Scale . . .
environment and is used to resize the sketched
entities with respect to the specified base point. On
invoking this tool, the Scale dialog box will be displayed,
as shown in Figure 17-2. Most of the options in this dialog
box are similar to those discussed in the Move dialog box [precise Input

n Chapter 4. [] optimize for Single Selection

Scale *

Select % @+ Base Point

Scale Factor

.. Apply Done ==
Select the sketched entities to be scaled then choose the i -

Base P(?int button; you wi!l be prompted to seleq the Figure 17-2 The Seale dialog box
base point. Select a base point; the Scale Factor edit box

will be highlighted. As you move the cursor in the graphics window, the entities will be resized
with respect to the cursor position and the value in the Scale Factor edit box will change dynami-
cally. You can also enter the required value manually in the Scale Factor edit box to resize the
entities. Alternatively, you can specify the coordinates of the base point by using the Inventor
Precise Input toolbar. To do so, select the Precise Input check box in the Scale dialog box; the
Inventor Precise Input toolbar will be displayed. Specify the coordinates to locate the base point.

FINDING THE CENTER OF GRAVITY
Ribbon: View > Visibility > Center of Gravity

This tool allows you to find the Center of Gravity (COG) of a model or an
assembly. To find the center of gravity, choose the Center of Gravity tool from
the Visibility panel of the View tab; the Autodesk Inventor Professional message box will be
displayed, as shown in Figure 17-3.

e Center of Gravity

Autodesk Inventor Professional x

The Center of Gravity is out of date. Would you like to update it now?

1Y

Figure 17-3 The Autodesk Inventor Professional
message box

Choose the OK button from the dialog box; the Center of Gravity triad will be displayed, as
shown in the Figure 17-4. The red arrow indicates the X-axis, the green arrow indicates the Y-axis,
the blue arrow indicates the Z-axis, and the yellow sphere indicates the location of the Center
of Gravity of the selected component. This triad also includes three selectable work planes and
a selectable work point at the origin of COG.
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You can use the COG symbol as a virtual reference in
the designing process. The triad can be used for
measuring the distance. To measure distance, choose
the Measure tool from the Measure panel of the
Inspect tab. Next, select one of the planes of the triad,
and then select a face of the model; the measurements
will be displayed in the Measure dialog box. For more
information on measurement tools, refer to Chapter 3.
If you modify the model, the triad becomes fade. For
updating the Center of Gravity, you need to remove
the existing COG triad. To do so, choose the Center
of Gravity tool from the View tab again; the COG will
disappear. Repeat the above procedure to display the
updated COG.

Figure 17-4 Center of Gravity triad

EXTRACTING THE iFEATURE

Ribbon: Manage > Author > Extract iFeature

E‘Ii_l-l Features such as slot and keyways are used in most of the designs with variation in

dimensions. In Autodesk Inventor, you can create these features as sketched features in
one design, and then extract and place them in other designs. These extracted features are
called as iFeature. The iFeature is created by using the Extract iFeature tool. Note that if a
feature created using the join operation is extracted as an iFeature and placed on the other
model, the material will be added to the model. Similarly, if the feature created using the cut
operation is extracted as an iFeature and placed on the other model, the material will be removed
from the model.

Note

@ The features created using the 2D sketches are known as Sketched Features. Extrude, revolve, and
sweep are some of the examples of the sketched features. The features that do not require a sketch
are known as Placed Features. Fillet, chamfer, threads, and shells are some of the examples of the
placed features.

After creating the required sketched features on the model, choose the Extract iFeature tool
from the Author panel of the Manage tab; the Extract iFeature dialog box will be displayed, as
shown in Figure 17-5. The options in this dialog box are discussed next.

Type Area

In this area, there are two radio buttons, Standard iFeature and Sheet Metal Punch iFeature.
By default, the Standard iFeature radio button is selected. This button is used to create the
iFeature that has to be placed in the part environment. You can select the Sheet Metal Punch
iFeature radio button if you want to create an iFeature that has to be placed in the part or sheet
metal environment. Also, note that if you want to create an iFeature using the Sheet Metal
Punch iFeature radio button, then make sure that the sketch of the original feature must have
a center point.
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E;‘ Extract iFeature *
Type
(®) Standard iFeature () Sheet Metal Punch iFeature
Selected Features Size Parameters
E:‘ iFeaturel Name Value Limit Prompt
==
Position Geometry
Mame Prompt
Manufacturing Depth
Specify Punch ID Custom
Simplified Representation
Unfold in Flat Pattern
E.‘ Save Cancel

Figure 17-5 The Extract iFeature dialog box

Selected Features Area

After invoking the Extract iFeature dialog box, you need to select the sketched feature to be
extracted as iFeature. Select a sketched feature from the Browser Bar; the feature will be displayed
in the Selected Features area along with all its dimensions. If you select a feature from this area,
the two buttons on the right of this area will get activated. Next, choose the button with arrows
pointing toward right; the dimensions of the selected feature will be displayed in the respective
column in the Size Parameters area.

Size Parameters Area

This area displays the dimensions and parameters to be edited at the time of inserting an iFeature
in another design. If you need to edit a particular parameter, then click in its corresponding
column and edit it.

Position Geometry Area

This area displays the reference geometry that defines the position of the iFeature. It is
recommended that you include all the dependent geometries in this area, so that they can be
used to define the position of the iFeature while inserting it.

Manufacturing Area

The options in this area will be activated only when you select the Sheet Metal Punch iFeature
radio button in the Type area. Using these options, you can specify the punch ID in the Specify
Punch ID edit box. If you have selected multiple features to create the sheet metal punch
iFeature, then you can specify the reference center point by choosing the Select Sketch button.
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Depth Area

The Custom edit box in this area is used to specify the punching depth.

After defining all parameters, choose the Save button; the Save As dialog box will be displayed.
This dialog box is used to save the iFeature created. The iFeature file will be saved in *.ide file
format.

INSERTING THE iFEATURE

Ribbon: Manage > Insert > Insert iFeature

[ InsertiFeatre 1 D€ Insert iFeature tool is used to insert the iFeatures into a model. To insert

an iFeature, choose the Insert iFeature tool from the Insert panel of the Manage
tab; the Open dialog box along with the Insert iFeature dialog box will be displayed, as shown
in Figure 17-6.

Now, you can select the iFeature either from the Open dialog box or close this dialog box and
then select the iFeature by using the Insert iFeature dialog box.

File Name: |

I— @ Libraries T Catalog V| G * e m.

m Content Center Files

Mame Date modified Type Size
Geometric Shapes 6/21/2021 6:21 PM File folder
Pockets and bosses 6/21/2021 6:20 PM File folder
Punches 6/21/2021 6:21 PM File folder
Slots 6/21/2021 6:19 PM File folder

Cancel

Preview not available

File name: *ide ~

Files of type:  Autodesk Inventor iFeatures (" ide) i

Project File: | Defaultipi Projects...

.i. @ ﬁﬁ | Options... Open Cancel
Z X

Figure 17-6 The Open dialog box along with the Insert iFeature dialog box

In the iFeature dialog box, the flow chart on the left shows four indicators and their names. The
active indicator turns green and the information of the respective indicator is displayed on the
right pane of this dialog box. These indicators are discussed next.

Select

This indicator is chosen by default. On the right side of this indicator, the Browse button is
available in a pane. Choose this button; the Open dialog box will be displayed. You can open
the required *.ide file using this dialog box.
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Position

When you open a *.ide file, the Position indicator will be activated and names of the reference
geometry such as work plane, point, axis, and line will be displayed in the list box. You need
to define the reference geometry in the model where you need to place it. To do so, click once
on the name of the reference geometry in the dialog box and then specify its position in the
drawing window.

Size

After defining the position of the reference geometry, choose the Next button; the Size indicator
will be activated and the dimensions will be displayed along with their names on the right pane
of the indicator. You can modify these dimensions according to your requirement.

Precise Pos.

After defining all the dimensions of the iFeature, choose the Next button; the Precise Pos.
Indicator will be activated and two radio buttons will be displayed in the Upon Completion of
Placement area on the right side of the pane. These radio buttons are discussed next.

Activate Sketch Edit Imnmediately
If you select this radio button and then choose the Finish button, the Sketching environment
will be invoked.

Do Not Activate Sketch Edit
By default, this radio button is selected. As a result, the Sketching environment will not be
invoked on choosing the Finish button.

After completing all the steps, choose the Finish button to place the iFeature.

CREATING iMates

Ribbon: Manage > Author > Create iMate

Some parts such as bolts, rods, washers, nuts, and flanges are used in many assemblies
in the same way. So, if you specify the mate references on such parts before they are
assembled, assembling these parts will be easier. These mate references are called iMates.
After defining an iMate on a part, if you place it in the

Assembly environment, it will be placed in its position | Creste iMate x
automatically. To create an iMate, first create the part | assemsly  wation
or subassembly and then invoke the Create iMate tool | rype Selections

from the Author panel of the Manage tab; the Create

iMate dialog box will be displayed, as shown in Figure = |- e
17-7. This dialog box is similar to the Place |2ft soluton
Constraints dialog box discussed in Chapters 9 and (0000 m d
10. However, in this dialog box, the Translation tab
is not available. Select the type of mate to be applied =
to the part from the Type area and then select the

face to which the mate has to be applied. Note that Figure 17-7 The Create iMate dialog box
you can select the type of mate from the Type area

OK Cancel Apply S




17-8 Autodesk Inventor Professional 2022 for Designers

available in the Assembly or Motion tab. At the lower | name
right corner of this dialog box, the More button is ||
provided. If you choose this button, the Create iMate
dialog box will expand. Figure 17-8 shows the partial
view of the expanded Create iMate dialog box. This | [JUseOffsetsResting Positon
expanded dialog box can be used to increase the
accuracy of the mate. The options in the expanded
dialog box are discussed next.

Limits  Matching

|:| Maxirnum

[minimum

Name Area

You can specify the name of the current iMate in the
edit box of this area. If you leave this area blank, a
default name will be given to the iMate.

Figure 17-8 Options in the expanded
Create iMate dialog box

Limits Tab

In Autodesk Inventor, you can specify the maximum and minimum limits of the constraint to be
applied to an iMate component. You can specify these limits in the Maximum and Minimum
edit boxes in the Limits tab. These options of the Limits tab have already been discussed in
detail in Chapter 9.

Matching Tab

In this tab, you can list the name of iMate with which the part will mate. When a part is placed
in the assembly, the system will first try to mate the part with the iMate located in the Match
List area. For adding, deleting, and moving the name in the list box, four buttons are provided
at the right side of the list box. These buttons are discussed next.

Add name to list
If you choose this button, the New Name edit box will be displayed in the Match List
=] list box. In the edit box, you can specify the name of the iMate to which this part has to
be assembled. For adding another name, you need to choose this button again.

Delete selected name
This button is used to remove the selected name from the Match List list box.

Move selected name up in priority
This button is used to move the selected name one step up in the Match List list box
1 to change the priority of matching.

Move selected name down in priority
This button is used to move the selected name one step down in the Match List list box
+ to change the priority of matching.

After setting the parameters, choose the OK button to apply iMates. You will observe that a circular
symbol is attached to a face of the part. Also, the iMates node is created in the Browser Bar.
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APPLYING iMATES IN THE ASSEMBLY ENVIRONMENT

For applying iMates in an assembly, place the first component to which iMates are assigned.
Next, you need to place the second component to which the respective iMates are assigned. To
place the second component, choose the Place tool from the

Component panel in the Assemble tab; the Place Component

dialog box will be displayed. The buttons in the iMates area =0

of this dialog box can be used to place the component using

different methods, refer to Figure 17-9. These methods are
discussed next.

Figure 17-9 The iMates area
in the Place Component dialog
box

Interactively place with iMates
This button is used to insert the component with matching iMates in an assembly. It
@ also enables you to place the number of instances in an assembly.

Automatically generate iMates on place

@@ | If this button is activated, then on inserting the iMate component, the component will
=) | automatically be assembled with the other respective iMate component of the assembly.
Choose the Open button after selecting the component and specifying the method;
the part will be placed in its position automatically. If you have chosen the Interactively place
with iMates button, then you will be prompted to specify the next location. Else, the tool will
be terminated.

VIEWING THE iPROPERTIES

File Menu: iProperties

properties 1 D€ properties of the component created in the Assembly environment in Autodesk

Inventor are known as iProperties. iProperties can be used for creating reports,
updating BOM, updating title block, and to display all the related information of the component
created. The options of iProperties are internally linked with the related component. Therefore,
whenever you update information in iProperties, it will be reflected in the related component.
You can invoke this tool by choosing the iProperties option from the File Menu. Alternatively,
right-click on the name of the component in the Browser Bar of the current assembly and
choose iProperties from the shortcut menu displayed; the iProperties dialog box of the
corresponding component will be displayed, as shown in Figure 17-10. The tabs in this dialog
box are discussed next.

General Tab
This tab displays the name, size, and type of the file. It also displays the date when the file was
created, modified, and accessed.

Summary Tab

This tab is used for classifying and managing files. This tab displays eight edit boxes: Title,
Subject, Author, Manager, Company, Category, Keywords, and Comments. You can enter
the required information in these edit boxes. On choosing the Apply button, this information
updates the Title blocks and BOM in the drawing file.
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I EBody iProperties (Master) iProperties

General Summary Project Status Custom Save  Physical

L’ applied_ifeature.ipt

Type of file: Autodesk Inventor Part
Opens with: v [Autodesk® Inventor@ 2022
Location: C:\W=zers'ASUS Laptop'\Downloadsc17 Inv_2021_tut\c17 tutd
Size: 91.00 KB
Size on disk: 91.00 KB
Created: Wednesday, July 7, 2021, 9:24:54FPM
Modified: Saturday, July 20, 2019, 9:54:50 AM
Accessed: Wednesday, July 7, 2021, 9:24:54PM
|1| Close Cancel Apply

Figure 17-10 The iProperties dialog box

Note
@ If the component is saved at any location after it is created then the iProperties dialog box displayed
will be different from the one shown in Figure 17-10.

Project Tab

This tab is used to define the project iProperties of the component.

Status Tab

This tab is used to define the status of the component.

Custom Tab

This tab is used to add the custom iProperties of the component.
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Save Tab

This tab is used for setting the saving options of the image of the component. In this tab, the
Save Preview Picture check box is selected by default. Therefore, it saves the thumbnail image
of the model that will be displayed in the Open dialog box. You can turn off the image from
the Open File dialog box by clearing this check box.

Occurrence Tab

This tab is used to specify the properties of the component. By using this tab, you can make any
component grounded, adaptive and so on. You can select the Degrees of Freedom check box to
display the degrees of freedom of a component. By selecting the Suppress check box, you can
suppress any component. You can also set preferences for BOM Structure by using the Current
Offset from the Parent Assembly Origin area and can place a component at an offset from
the parent assembly. Note that, the Occurrence tab will be available only when you invoke the
iProperties dialog box by right-clicking on the component of an assembly in the Browser bar
and choose the iProperties option from the shortcut menu.

Physical Tab

This tab is used to calculate and display the physical and inertial properties of the model. This helps
you analyze how the differences in materials, tolerances, and dimensions can affect the model. To
analyze the physical properties, select the required material from the Material drop-down list; the
values of density, mass, area, and volume of the model are displayed for the selected material. Note
that the Material drop-down list will be activated only in the part environment. The coordinates
of the COG are displayed in the General Properties area. In the Inertial Properties area, the
Principal, Global, and Center of Gravity buttons are available. By choosing these buttons, you
can view the inertial properties of the component for the applied materials.

CREATING USER-DEFINED DRAWING SHEETS

Autodesk Inventor provides you an option to create user-defined drawing sheets by defining border
and title block according to your requirement. The procedures to create the user-defined drawing
sheets are discussed next.

Whenever you open a drawing (.idw) file, the Drawing Resources node will be displayed in the
Browser Bar. Click on the * sign beside the Drawing Resources node to expand it. Three sub-
nodes will be displayed under this node. These sub-nodes and their options are discussed next.

Sheet Formats

Click on the + sign of this sub-node; a list of drawing sheets will be displayed. If you right-click
on any of these sheets; a shortcut menu will be displayed, as shown in Figure 17-11. Choose
New Sheet from the shortcut menu; the Select Component for View on Sheet: Sheet dialog
box will be displayed, as shown in Figure 17-12. In this dialog box, choose the button on
right of the Document Name drop-down list and open a part or an assembly; the path of the
selected component will be displayed in the Document Name drop-down list. Choose the OK
button from the Select Component for View on Sheet: Sheet dialog box; the selected model
will be drafted in the new sheet with a number of views. Note that the number of views and the
size of the new sheet depend upon the name of the sheet selected in the Browser Bar.



17-12 Autodesk Inventor Professional 2022 for Designers

Drawing1

= Drawing Resources

—: L] Sheet Formats

i

[l siee, Landscape, 1 view]
<[ size, 2 view

[SCsize, 4view

(=D size, 6 view

o [JEsize, 7 view

":‘ [/ Borders

+ || Title Blocks Select Component far View on Sheet: Sheet %

L% sketch Symbols Document Name:

—-[dsheet:1 <Select Document> ~
Default Border
+ [ ANSI - Large

oK Cancel

Figure 17-11 Creating a new Figure 17-12 The Select Component
sheet using the shortcut menu for View on Sheet:Sheet dialog box

Borders

The Borders sub-node has a predefined border style, which will be applied to the sheet. You
can also define and insert a new border and new zone border in the drawing sheet using this
node. The procedures to define a new border, border zone, and inserting a new border zone
are discussed next.

Defining a New Border

To define a new border, choose the Define New Border option from the shortcut menu
that is displayed on right-clicking on the Borders sub-node, refer to Figure 17-13;
the sketching environment will be activated. You can draw a border in the sketching
environment based on your requirement. After drawing the border, choose the Return tool
from the Quick Access Toolbar or choose the Finish Sketch button from the Exit panel of
the Sketch tab; the Border dialog box will be displayed, as shown in Figure 17-14. Enter a new
name in the Name edit box and choose the Save button; the new name will be displayed in the
Browser Bar below the Borders node.

Parallel key

o Drawing Resources

; + [d| Sheet Formats

Border *
: | ske D Define New Zone Bor% Mame:
- [Jsheet:  Expand Al Chidren
Det e Save Discard Cancel
+ LA powTo..,
Figure 17-13 Choosing the Define New Figure 17-14 The Border dialog box

Border option from the shortcut menu
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Defining a New Zone Border

To define a new zone border, choose the Define New Zone Border option from the shortcut
menu that is displayed on right-clicking on the Borders sub-node; the Default Drawing
Border Parameters dialog box will be displayed. In this dialog box, you can set the horizontal
and vertical zones of the border from the respective areas. If you choose the >> button from
the lower right corner of this dialog box, the Default Drawing Border Parameters dialog box
will expand, as shown in Figure 17-15. In the expanded area, you can set the appearance of the
border. After setting all parameters, choose the OK button; the new border with its dimensions
will be displayed in the sketching environment, where you can edit these dimensions. You can
modify the border using the tools provided in the sketching environment. After moditying the
border according to the requirements, choose the Return button from the Quick Access Toolbar;
the Borders dialog box will be displayed again, refer to Figure 17-14. Enter a new name in the
Name edit box and choose the Save button; the new name will be displayed in the Browser
Bar below the Borders sub-node.

Default Drawing Border Parameters X
Horizontal Zones Vertical Zones
Mumber of Zones Number of Zones
Label Label
() Alphabetical (@) Alphabetical
(®) Numeric () Mumeric
(O None () None
L\T,_‘ OK Cancel
Text Style: Text Layer: Line Layer:
By Standard ~ | |By Standard ~ | |By Standard ~
Label Zones From Delimit Zones By
(®) Bottom,Right (®) Line Em T
() Top/Left () Arrowhead
Sheet Margins
Top Right Bottom Left
| 1000 | | o.500 | | 1000 | | 0.500 |

Figure 17-15 The Default Drawing Border Parameters dialog box

Inserting a New Border Eloraningt

For inserting a new border, you need to delete the existing = Eloraving Resources
border. To do so, right-click on the Default Border option | T et
available in the Sheet:1 node of the Browser Bar; a shortcut Default Border
menu will be displayed, as shown in Figure 17-16. Choose [N BORDER
the Delete option from the shortcut menu; the existing border

+ [0 Title Blocks

P 1% Sketch Symboals
will be deleted from the drawing sheet as well as from the - Qeet”
Browser Bar. After deleting the border, click on the Borders i':,_—.;EANE M iar
Delete

sub-node; all available borders will be displayed. Double-click =
on any of the borders; the selected border will be displayed e

in the active drawing sheet. Figure 17-16 Deleting the existing

border using the shortcut menu
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Title Blocks

The Title Blocks sub-node has a predefined title block. You can define a new title block using
the procedure given next.

Defining a New Title Block

Choose the Define New Title Block option from the shortcut menu of the Title Blocks sub-node,
as shown in Figure 17-17; the sketching environment will be activated. You can draw a title block
in the sketching environment based on your requirements. After drawing the title block, choose
the Finish Sketch button from the Exit panel of the Ribbon; the Title Block dialog box will be
displayed, as shown in Figure 17-18. Enter a new name in the Name edit box and choose the
Save button; the name will be displayed in the Browser Bar below the Title Blocks sub-node.
You can insert a new title block in a way similar to inserting a new border.

Drawingl
— Drawing Resources
i +[[3] sheet Formats

[ Borders
| Default Border
— | NEW BORDER.
H F——
1 + ] i Hoc Repeat Finish Sketch
- [i#] sketch 51
i | e Ctrl+C
— [= sheet:1 B it
. [C] Default 6 L= Define New Title Block Mame:
+[JaNsi-Lz  SortByName | |
Expand All Children
Collapge All Children

Title Block x

Save Discard Cancel
How To...

Figure 17-17 Defining a new title Figure 17-18 The Title Block dialog
block using the shortcut menu box

Creating a Customized Title Block

You can create a customized title block that gets updated when

its iProperties change. To do so, right-click on the name of the Edoravng2
title block that is available in the Browser Bar below the Title _ i za;h:gaf:::;:s

Blocks sub-node; a shortcut menu will be displayed, as shown .

in Figure 17-19. Choose the Edit option from the shortcut :

menu; the sketching environment will be activated. Also, the Eﬂr Repeat Finish Sketch
title block along with the dimensions and names will be + [sheet:] 2 CPY ctr+C

.+ Borders
[=l| Title Blocks

displayed in the graphics window, as shown in Figure 17-20. Insert
These names are internally linked with the iProperties of the
active drawing file. Therefore, it is recommended that while
editing the title block, keep the required names and delete
the remaining portion of the title block.

Edit
How To...

Figure 17-19 The shortcut menu
displayed on right-clicking the
title block name
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32 25-e~] 40 23—t 30—y
T:=1I:: =1 1 1 ela

.% Iy 7 TRTTET 7 Y ate

(1] > > CREATION DATE:
30 -

<Cl > = B s :i
<PART NUMBER> spevtshaneniqBRRanjter of sheets>
[= Ill
60 s——LE—lE 20—~
170

Figure 17-20 Title block displayed in the Sketching environment

If you try to move the name of the title block, then the complete title block will be moved. To
avoid this movement, right-click on the required name and then choose the Text Box option
from the shortcut menu, as shown in Figure 17-21. Now, you can move the required name. In
this way, you can move all the required names and delete the remaining portion of the title block.

Draw a new layout for the title block using the tools provided in the Create panel of the Sketch
tab and move the names to the required area, refer to Figure 17-22.

After customizing the title block, choose the Return tool from the Quick Access Toolbar; the
Save Edits message box will be displayed, as shown in Figure 17-23. If you choose the Yes button
from this message box, then the changes made to the title block will be saved in the existing
title block and will be displayed in the graphics window, as shown in Figure 17-24. If you choose
the Save As button, the Title Block dialog box will be displayed. In the Name edit box of this
dialog box, you can enter the name for the title block. On doing so, the name will be displayed
in the Title Blocks sub-node in the Browser Bar.

% Delete J

(_ Undo <‘F1;t Number '.\_*%’ Move )l‘
o]

| Edit text
W y
@ § : @

/" RepeatLine

I, Copy Ctrl+C
Align...

" Save Title Block
Text Box
Convert to Geometry
Rotate 80 CW
Rotate 90 CCW.

Ff, snap to Grid

[! Show All Constraints ~ F5 I I T 2577 %‘; PR

ROVED BY.

o

i Measure M =gnea oy ° PP oy
AUTHOR'

=
e

CREATION DATE
<TIFLE>

I<PART NUMBER> <REVISIOR|NUMBER
1

=51

ET=

Region Properties )
.S'. Edit Text Style... <COMPANY>

*= Previous View FS

Help Topics... 1

Figure 17-21 Choosing the Text Box Figure 17-22 Editing a title block in the Sketching
option from the Marking Menu environment
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Save Edits * 'CADCIMTechnologies
Save Edits to 1507
TADCIM
25/6/2019
Yes Mo Save As... Cancel
Figure 17-23 The Save Edits message box Figure 17-24 Customized title block created

Next, choose the iProperties option from the File Menu to invoke the iProperties dialog box.
Enter the required information in different tabs of the dialog box for the current drawing.
Now, choose the Apply button and then the Close button from the iProperties dialog box; the
information will be displayed in the title block, see Figure 17-25.

'CADCIM Technologies
CADCIM XYz ‘Template
Casting
25/06/2019 "25/06/2019

Figure 17-25 The updated title block with the change in its iProperties

Inserting a New Title Block

Click on the * sign of the Title Blocks sub-node in the Browser Bar; a list of all available title
blocks will be displayed in the Browser Bar. You can insert any of the title blocks from this list.
Note that you need to delete the existing title block before inserting a new one. To delete the
existing title block, click on the * sign of the sheet in the Browser Bar; a node list will be
displayed. Next, right-click on the name of the title block available below the name of the sheet
Sheet:1 in the Browser Bar; a shortcut menu will be displayed, as shown in Figure 17-26. Choose
the Delete option from the shortcut menu; the existing title block will be deleted. To activate
another title block, double-click on the name of the title block that is available in the Title Blocks
sub-node in the Browser Bar; the selected title block will be displayed in the drawing window.

Tip
Q It is recommended that you save the file after creating the customized border and title block so
that you can use it as a template file.

Creating Sketch Symbols

Sometimes in the drafting process, you need to use some special symbols frequently. For this,
Autodesk Inventor provides a special sub-node, named Sketch Symbols. You can use this option
to create a customized sketch symbol that can be used whenever you want. To do so, right-click
on the Sketch Symbols sub-node in the Browser Bar; a shortcut menu will be displayed,
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as shown in Figure 17-27. If you choose Define New Symbol from the shortcut menu, the
sketching environment will be activated. You can draw any symbol by using the sketching tools
of the Create panel in the Sketch tab. After creating a symbol, if you choose the Return tool
from the Quick Access Toolbar or choose the Finish Sketch button from the Exit panel of the
Sketch tab, the Sketch Symbol dialog box will be displayed. Enter a name for the symbol in
the Name edit box and choose the Save button; the name will be displayed below the Sketch
Symbols in the Browser Bar. If you double-click on that name in the Browser Bar, then the
cursor will be changed to plus sign and the created symbol gets attached to it. Next, if you click
anywhere in the drawing window, the sketch symbol that you created will be placed at that point.
You can place a number of sketch symbols in the graphics window by clicking at various points.

Drawing2 5
Drawing2
- Drawing Resources
+-|[d| Sheet Formats
+./[d| Borders

- Drawing Resources
+-|[3] Sheet Formats

+- /3| Borders
[l Titke Blocks —[F5] Title Blocks
[=150 [=150
. 1] Sketch Symbols —[EEE . repeatFinish Sketch
- Sheet: 1 j# syr
Default Border = [dsheet:1 B gy SikiE
- EE‘ . Defau Create New Folder
A [ Repeat New
T -[J150 Insert
Delete #¢ Fie  Save All to Symbol Library
Edit Definition 1% Define New Symbel
Expand All Children Expand All Children
Collapse All Children Collapse All Children
How To... How Ta...
Figure 17-26 Choosing the Delete Figure 17-27 The shortcut menu
option from the shortcut menu of the Sketch Symbols sub-node

Tip

O If you have generated the drawing views of a model or an assembly, you can display the COG
mark on it. 1o do so, click on the + sign on the left of the View node; the model or assembly
node will be displayed. Next, right-click on the corresponding model or assembly node to
imvoke a shortcut menu. Choose the Center of Gravity option from this shortcut menu,; a
plus (+) sign will be displayed on the related drawing view indicating the position of the
COG of that model.

IMPORTING AutoCAD BLOCKS INTO Inventor

Ribbon: Annotate > Symbols > Import AutoCAD Block

% In Autodesk Inventor, you can import the blocks created in AutoCAD into the drawing
- sheets of Inventor. Also, you can move, scale, and rotate them in Inventor. To import
an AutoCAD block into Inventor, first create it in AutoCAD and then save it. Next,
start a new drawing (dwg) file in Inventor and choose the Import AutoCAD Block
tool from Annotate > Symbols in the Ribbon; the Import Block dialog box will be displayed,
as shown in Figure 17-28. Note that the Import AutoCAD Block tool will be available only when
you select the .dwg template from the Create New File dialog box to create a new drawing file

Impor...
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Browse to the required AutoCAD file and then select it; all blocks created in the file will be
displayed in the form of icons in the Block Definitions area of the Import Block dialog box,
see Figure 17-28. Select the required block from the Block Definitions area and then specify the
scale and rotation angle values in the Scale and Rotate edit boxes at the bottom of the dialog
box. Next, choose the Insert button; the Import Block dialog box will disappear and you will be
prompted to insert the AutoCAD block. Note that the Insert button will be available only when
you select a block from the Block Definitions area. Click on the drawing sheet at the location
where you want to place the block; the block will be placed at the specified location. You can

place any number of AutoCAD blocks in the drawing sheet.

I importBloc
e cenerries | ot [t e e o m-

Mame . Date modified
£S CsDs 6/2/2009 2:29 AM
ES Cs06 6/2/2009 3:34 AM
S cso7 6/2/2009 3:34 AM
£S c5de 1/10/2007 12:28 PM
S CsExR 7/28/2010 515 AM
ES Csexrz 6/2/2009 1:14 AM
£S o um 6/27/2009 5:55 AM
BS cstum2 5/31/2009 6:23 AM
ES csTum3 6/2/2009 1:27 AM
£ o TuTs 6/27/2009 12:17 AM
ES costut2 6/27/2009 12:14 AM
ES cl4exrl-proe-wf 11/23/2006 8:02 PM
£ fige-9 4/2/2009 417 AM
S fige-17 6/2/2009 3:34 AM
ES figs-12 6/2/2009 2:27 AM
2S5 gmr 5/31/2009 2:21 AM
ES tut0s-all 5/28/2011 7:31 AM
(== tutorials £1/2011 T:51 AM

File name: armr ~ Cpen

Files of type: | Autodesk Drawing Files {*.dwa) ~ Cancel

Block Definitions g8~

I A i

Filled-1 gmr_Sheet...

kAl

gmr_Sheet... gmr_Sheet...

W

Scale 1.000
Rotate 0.0

Figure 17-28 The Import Block dialog box
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After inserting the required block, right-click and then choose Done [ESC] from the shortcut
menu; the inserted blocks will be displayed in the AutoCAD Blocks node under the Sheet node
in the Browser Bar, refer to Figure 17-29. Expand the AutoCAD Blocks node to display the
inserted blocks. If you double-click on a block, the AutoCAD Blocks dialog box will be displayed,
as shown in Figure 17-30. In this dialog box, you can specify the scale and rotation angle values
in their respective edit boxes. By default, the Static check box is selected in this dialog box. As
a result, the AutoCAD block behaves as static entity and you cannot rotate or scale it manually.
However, you can move it by using the base point grip that is displayed in green in the drawing
sheet. If you clear this check box, the grips surrounding the block will be displayed. With the
help of these grips, you can scale, move, and rotate a block manually. The yellow and blue grips
are used to scale and rotate the block, respectively.

Figure 17-31 shows an AutoCAD block with grips displayed on it in the drawing sheet.

/ Note
@ You can also invoke the AutoCAD Blocks dialog box by using the Drawing Resources node in
~ the Browser Bar. 10 do so, expand the Drawing Resources node; the sub-nodes of this node
will be displayed, refer to Figure 17-29. Expand the AutoCAD Blocks node; all the inserted
blocks will be displayed under this node. Next, right-click on the required block and choose the
Edit AutoCAD Blocks option from the shortcut menu; the AutoCAD Blocks dialog box will be
displayed, refer to Figure 17-30.

IS Drawingl
- Drawing Resources
+ [d|Sheet Formats
+ [d|Borders
-+ [E it Blodks
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- 5| AutoCAD Blocks
T3 Filled-1
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- cadeims ;
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Default Border
+ [ ANSI -Large
—[E2] AutoCAD Blacks

[ cadadm1
- 1:;;' cadcm?2
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Eé; caddm5
E@ cadcms ./
Figure 17-29 AutoCAD blocks in the

Sheet and Drawing Resources nodes
in the Browser Bar

Drawing Resource node

AutoCAD Blocks in
Sheet node

caddm?2
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]
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Symbaol Clipping
Static
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Figure 17-30 The AutoCAD Blocks dialog box




17-20 Autodesk Inventor Professional 2022 for Designers

o o

Figure 17-31 Grips displayed on an AutoCAD block

TUTORIALS
Tutorial 1

In this tutorial, you will create a shaft with a groove, as shown in Figure 17-32. Extract the groove
as an iFeature and place it on a hexagonal bar, as shown in Figure 17-33.
(Expected time: 45 min)

50
@50
|
,
2% 45° |
|
|
|
150 |
100 |
@40 | @44
i | i
8 10 ! |
15 f 1 | 18
|
f N2 x 450 ' f

Figure 17-32 A shaft with a groove Figure 17-33 Hexagonal bar with a groove
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The following steps are required to complete this tutorial:

Create a circular shaft and chamfer the sharp edges.

Draw the profile for the groove on the XZ plane and apply the dimensions to the profile,
refer to Figure 17-34.

Revolve the profile about the Z-axis using the Cut option, refer to Figure 17-35.

Extract the iFeature of the groove using the Extract iFeature tool.

Create a hexagonal shaft and place the iFeature by using the Insert iFeature tool.
Save the model.

Creating the Shaft

First, you need to create a shaft and then create an iFeature from it.

Choose the Start 2D Sketch tool from the Sketch panel of the 3D Model tab; the default
planes are displayed and you are prompted to select the sketching plane.

Now, select the XZ plane as the sketching plane from the graphics window; the Sketching
environment is invoked and the XZ plane becomes parallel to the screen.

On the XZ plane, create a circle of 50 mm diameter such that its center coincides with the
origin. Next, exit the Sketching environment.

Extrude the profile to 100 mm using the Extrude tool.

Apply the chamfer of 2 mm at the ends of the shaft.

Creating the Groove

1.

Choose the Start 2D Sketch tool from the Sketch panel of the 3D Model tab and select the
XY Plane as the Sketching plane; the Sketching environment is invoked.

Use the ViewCube to orient the model if required, see Figure 17-34.

Press the F7 key to slice the model.

Draw a rectangle and apply vertical dimensions (20 mm and 25 mm) to it with respect to
the origin, refer to Figure 17-34. Apply the horizontal dimension (15 mm) to it with respect

to the origin, see Figure 17-34. Also, dimension the length (8 mm) of the rectangle.

Choose the Finish Sketch tool from the Exit panel of the Sketch tab; the part modeling
environment is displayed.

Invoke the Revolve tool. Next, choose the Cut option from the Output node and create the
groove feature with Y axis as the axis of the revolution, see Figure 17-35.
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7.

Figure 17-34 Dimensions applied to the profile Figure 17-35 The shaft after creating

for creating a groove the groove

Save the part with the name shafi_ileature.ipt at the following location:

C:\Inventor_2022\c17\Tutoriall

Creating the iFeature

1.

Choose the Extract iFeature tool from the Author panel of the Manage tab; the Extract
iFeature dialog box is displayed.

Select the Revolutionl node in the Browser Bar; the name of the feature and its
related dimensions and references are displayed in the Selected Features area of the Extract
iFeature dialog box.

Select Center Point from the Browser Bar; the Center Point is displayed along with
Extrusionl, Chamferl, and Revolutionl in the Selected Features area. It is also displayed
in the Position Geometry area with the name Point].

Right-click on Extrusionl in the Selected Features area and then choose Remove Feature
from the flyout displayed; all features except Center Point and Revolutionl are removed
from the Selected Features area.

Select the Revolutionl node from the Selected Features area and choose the double arrow
pointing toward the right; all related dimensions are displayed in the Size Parameters area
and Sketch Planel is displayed in the Position Geometry area.

Select Y Axis from the Browser Bar; the Y Axis is displayed in the Selected Features area.
It is also displayed in the Position Geometry area with the name Axisl.

You will notice that in the Size Parameters area, default names are displayed in the Prompt
column. You need to change these names. Changing the default names will make identifying
and modifying a parameter easy when you insert iFeatures. Follow the steps given next to
edit default names.



Miscellaneous Tools 17-23

7. Click once in the field corresponding to the value 20 mm in the Prompt column; an edit
box is displayed.

8. Enter ID in the edit box.

9. Similarly, change the default names for the remaining values in the Prompt column as given
next in the table.

Value Prompt to be modified as
15 REF
25 OD
8 GW

10. Change the field corresponding to Sketch Planel to Sketch Plane in the Prompt column
of the Position Geometry area.

11. Similarly, change the fields corresponding to Pointl and Axis1 to Center Point and Y Axis,
respectively in the Prompt column of the Position Geometry area. After changing the
prompts, the Extract iFeature dialog box appears, as shown in Figure 17-36.

E:' Extract iFeature Y
Type
(®) Standard iFeature (C) sheet Metal Punch iFeature
Selected Features Size Parameters
E:‘ iFeatureé MNarme Value Limit Prompt ~
Ly mxis e dio 15mm Mone REF
L@ Axis1 [Axis] di1 25mm  None oD
A . o A
4 Center Point << dé 8 mm None GW "
l_ﬁ Point1 [Point] d7 20 mm MNone mn
l:;i Revolution1 Position Geometry
m Reference Line3 [Refer Name Prompt ~
B2y Sketch Plane3 [Sketch Sketch Plane1 Sketch Plane
x= d10 [15 mm] Axisl ¥ Axis v
%= d11 [25 mm]
%= d& [8 mm] Manufacturing Depth
%= d7 [20 mm] Spedfy Punch ID Custom

Simplified Representation

< > Unfold in Flat Pattern

Ij,.‘ Save Cancel

Figure 17-36 The Extract iFeature dialog box

12. Choose the Save button from the Extract iFeature dialog box; the Save As dialog box is
displayed.
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13. Save the iFeature with the name groove_ileature.ide at the following location:

C:\Inventor_2022\c17\Tutoriall

14. Save the part file and close it.

Creating the Hexagonal Shaft

1.

2.

Start a new part file.

Choose the Start 2D Sketch tool from the Sketch panel of the 3D Model tab; the default
planes are displayed and you are prompted to select the sketching plane.

Now, select the XZ plane as the sketching plane from the graphics window; the Sketching
environment is invoked and the XZ plane becomes parallel to the screen.

Create a hexagon on the XZ plane, as shown in Figure 17-37.

Figure 17-37 Sketch for creating the Hexagonal
shaft

Extrude the profile up to 150 mm.

Choose the Insert iFeature tool from the Insert panel of the Manage tab; the Insert
iFeature dialog box along with the Open dialog box is displayed. Close the Open dialog
box by choosing the Cancel button from Open dialog box.

Choose the Browse button from the Insert iFeature dialog box; the Open dialog box is
displayed again.

Open the groove_ileature.ide file from C:\Inventor_2022\c17\Tutoriall; the Position indicator
is activated. Also, on the right of the pane, Sketch Planel is highlighted in red. On the
lower side of the dialog box, a prompt is displayed prompting you to select the sketching
plane for placing iFeature.

Select XY Plane from the Browser Bar; the Pointl from the right pane turns red and you
are prompted to select the Center Point.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

Select Center Point from the Browser Bar; the Axisl from the right pane turns red and
you are prompted to select the Z Axis.

Select the Y Axis from the Browser Bar.

Choose the Next button in the Insert iFeature dialog box; the Size indicator is highlighted in
the left pane of the dialog box. Similarly, in the right pane of the dialog box, the dimensions
of the iFeature are displayed.

Click on 20 mm in the right pane; ID is displayed in the prompt box.

Enter 22 mm in place of 20 mm.

Click on 15 mm; REF is displayed in the prompt box. Enter 18 mm in place of 15 mm.
Click on 25 mm; OD is displayed in the prompt box. Enter 30 mm in place of 25 mm.

Click on 8 mm; GW is displayed in the prompt box. Enter 10 mm in place of 8 mm.

Choose the Refresh button from the dialog box; the
preview of the iFeature is displayed on the model.

Choose the Next button; the Precise Pos. indicator
is activated on the left in the dialog box and the Do
Not Activate Sketch Edit radio button is selected
automatically.

Choose the Finish button; the iFeature is applied
to the model, refer to Figure 17-38. You will notice
that the iFeaturel:1 node is created in the Browser
Bar.

Save the model with the name applied_iFeature
at the location C:\Inventor_2022\c17\Tutoriall and  Figure 17-38 The ileature applied to
then close the file. the model

Tutorial 2

In this tutorial, you will create a circlip and a shaft using the dimensions given in Figures 17-39
and 17-40. Apply iMates to the circlip and the groove of the shaft. Then, assemble the
parts using the Insert constraint, as shown in Figure 17-41. (Expected time: 45 min)
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The following steps are required to complete this tutorial:

Create the shatft.

Apply iMates to the groove of the shaft using the Create iMates tool.

Create the circlip and apply fillets according to dimensions.

Apply iMates to the circlip using the Create iMates tool.

Place the shaft in the new assembly file.

Place the circlip into the assembly using the Automatically generate iMates on place button
from the Place Component dialog box.

g. Save the Assembly.

o a0 oW

32°
DETAIL A
F(O'g) SCALE 2:1
Ra71 ‘ THICKNESS =2.15MM
R22.9 -~ 5.1

Figure 17-39 The circlip for Tutorial 2
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Figure 17-40 A shaft with a groove Figure 17-41 Final assembly

Applymg iMates to the Shaft
Create the shaft with groove, refer to Figure 17-40
for dimensions.

Create iMate =

Assembly  Motion

Type Selections
2. Choose the Create iMate tool from the Author & | ol |
panel of the Manage tab; the Create iMate Offset: Solution

dialog box is displayed. Choose the Insert [oo0mm 5] \—‘% )

button from the Type area.

E‘ OK Cancel Apply <<
3. Choose the >> button available at the lower —
right corner of the dialog box; the dialog box [insert_1
expands.
Limits = Matching
4. Enter insert_l in the Name edit box and then nseri 3

choose the Matching tab; the Match List area is
displayed, see Figure 17-42.

«| [ [ [+

5. Choose the Add name to list button from the
Match List area; an edit box is displayed in the
list box.

Figure 17-42 The Create iMate dialog box
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6. Enter insert_2 in the edit box displayed, refer to Figure 17-42.

7. Accept the default settings for the rest of the options and select the inner edge of the groove

from the graphics window.

8. Choose the Apply button and then the Cancel button to close the dialog box.

9. Save the model with the name shaft.ipt and close the file.

Creating the Circlip

1.

Start a new part file and invoke the Sketching environment by selecting XZ plane as the
sketching plane.

Draw the profile for creating a circlip and then apply dimensions to it, as shown in
Figure 17-43.

After drawing the sketch, extrude the profile up to 2.15 mm.

Apply the fillets of 1 mm radius to the model. The model after creating the fillets is shown
in Figure 17-44.

5.1

45.8

Figure 17-43 Dimensions for circlip Figure 17-44 Final rotated model of circlip

Applying iMates to the Circlip

1.

Choose the Create iMate tool from the Author panel of the Manage tab; the Create @
iMate dialog box is displayed. Now, choose the Insert button from the Type area.

Choose the >> button from the lower right corner of the dialog box; the dialog box expands.

Enter insert_2 in the Name edit box. Note that this is the name you entered in the Match
List area of the Create iMate dialog box while setting the iMate of the shaft, refer to
Figure 17-42.
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8.

Choose the Matching tab from the Create iMate dialog box and then choose the +
Add name to list button from the Match List area; an edit box is displayed in the Ell
list box.

Enter insert_1 in the edit box displayed. Note that this is the name you had specified as
the name of iMate of the shaft.

Choose the inner edge of the circlip.

Accept the default settings for the rest of the options. Next, choose the Apply button and
then the Cancel button to close the dialog box.

Save the model with the name circlip.ipt and then close the file.

Assembling the Circlip and the Shaft Using iMates

1.

6.

Start a new assembly file and choose the Place tool from the Component panel of the g5
Assemble tab; the Place Component dialog box is displayed.

Place

Place the component shaft.ipt in the graphics window.

Again, invoke the Place Component dialog box by choosing the Place tool from the Assemble
tab.

Choose the Automatically generate iMates on place button from the iMates area of the
Place Component dialog box.

Open the part file circlip; the circlip is automatically assembled with the shaft, as shown in
Figure 17-45.

Figure 17-45 Final model after applying the iMates

Save the assembly with the name iMate_assembly.iam at the location given below:

C:\Inventor_2022\c17\Tutorial2
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Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of
this chapter:

1.

8.

9.

The Scale tool is used to resize the selected sketched entities with respect to the specified

The triad of the Center of Gravity can be used for measuring

You can specify the punching depth in the area for creating a Sheet Metal Punch
iFeature.

The file format of iFeature is

You need to the existing border before inserting a new type of border into a
sheet.
When you open the required *.ide file, the indicator is activated automatically for

inserting the iFeature.

In Autodesk Inventor, you cannot find the Center of Gravity of an assembly in the
drawing environment. (1/F)

The features created by using 2D sketches are known as placed features. (T/F)

iMates are used to place parts in their proper positions automatically. (T/F)

10. The Translation tab is available in the Create iMate dialog box. (1/F)

Review Questions

Answer the following questions:

1.

2.

Which of the following buttons from the Place Component dialog box is used to insert a
component with matching iMates into an assembly?

(a) Create iMate (b) Interactively place with iMates
(c) Create iFeature (d) Automatically generate iMates on place

Which of the following tabs is used to calculate and display the physical and inertial properties
of a part or an assembly?

(a) Physical (b) Summary
(c) Project (d) Custom



Miscellaneous Tools 17-31

10.

Which of the following environments is invoked when you choose the Define New Title
Block option from the shortcut menu of the Title Blocks node?

(a) Drawing (b) Part
(c) Sketching (d) Assembly

Which of the following dialog boxes will be displayed if you choose the Define New Zone
Border option from the shortcut menu that is displayed on right-clicking on the Border
node?

(a) Border (b) Default Drawing Border Parameters
(c) Title Block (d) Name
When the Size indicator is activated, will be displayed on the right pane of the

Insert iFeature dialog box.

You cannot set the priority of the Mate reference in the Create iMate dialog box. (1/F)
There is only one button available in the Selections area of the Create iMate dialog box. (T/F)
A feature must include a center point for creating a Sheet Metal Punch iFeature. (T/F)

The iProperties dialog box can be used for creating reports, updating BOM, and updating
title blocks. (T/F)

When you open an *.idw file, the Drawing Resources folder is displayed in the Browser
Bar. (T/F)

EXERCISE
Exercise 1

Create a Nut according to the dimensions shown in Figure 17-46. The threads of the Nut to
be created are ANSI Metric M Profile with a size of 14 and M14X2 designation. Next, apply
the iMate constraints on the Nut and bolt. For dimensions of the bolt, refer to Tutorial 2 of
Chapter 8. Assemble both the nut and the bolt using the iMates. The final model is shown in
Figure 17-47. (Expected time: 45 min)
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Figure 17-46 Dimensions for creating the Nut Figure 17-47 Final assembly after applying
the iMates

Answers to Self-Evaluation Test
1. base point, 2. distance, 3. Depth, 4. *.ide, 5. delete, 6. Position, 7. F, 8. F, 9. T, 10. F



